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1.How to install eFon Operator Panel and log

on the first time

Here is the download link:

http://www.yeastar.com/download/eFonOperatorPanel 1.0.0.8B

eta.exe

Before logon, you must enable AMI (AMI setting->Enable AMI) add
permitted IP address/subnet mask and apply changes on MyPBX.

AMI Settings
¥/ Enable AMI

User Name : |efonadmin

Password - |pass123456

IP Restriction

Permitted 'IP address/Subnet mask’ : 192.168.2.46/255 255 255 0

Permitted IP address/Subnet mask € - +  Add

o  Save & Cancel

Figure 1
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Run ‘eFonOperatorPanel.exe’ and click 'next’.

2 i o

Welcome to the eFon Operator
Panel Installation!

| Q;, - This =etup program will install eFon Operator Panel on your
S hlj::} computer. Click Exit if you do not want to install this application.
S Click Mext to continue the installation.

WARMNING: This program is protected by international copyright
law and
treaties.

Unauthorized reproduction or distribution of this program, or any
portion of it, may result in severe civil and criminal penalties and
will be prosecuted to the maximum extent of the law.

Next> | | Exit

Figure 2

Tick I agree with the above terms and conditions’, then click ‘next’ ‘next’.

5 ot on o e =

License Agreement

To proceed with the installation, you must accept this License
Agreement. Flease read it carefully.

Entering into this Agreement: eFon Operator Fanel

-~
This End User License Agreement constitutes a valid and binding agreement EI
between Yeastar's eFon Operator Panel software ('Software') and You,as a user,
for the use of the Software.

Article 1 License and Restrictions

1.1 License. Subject to the terms of this Agreement, Yeastar hereby grants You
a limited, personal or company, non-commercial, non-exclusive, non-
sublicensable, non-assignable, non-free of charge license to download, install
and use the Yeastar Software on Your computer.

[¥]1 agree with the above terms and conditions

< Back [ Next> | | Exit

Figure 3
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Choose the folder which you want to install eFon Operator Panel in.

i v oo o ==

Destination folder

Select a destination folder where eFon Operator Panel will be
installed.

s

Setup will install files in the following folder.

If vou would like to install eFon Operator Panel into a different folder then click
Browse and select another folder.

Drestination folder

D:\eFon Operator Panel E Browse... ;

<Back || mNext> | [ Exit

Figure 4
Click ‘next’ -> ‘next’-> ‘finished’.
Bt o0 o e S ==

eFon Operator Panel has been
successfully installed!

Click Finish to complete the installation.

Figure 5
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When you click *finish’, the following setting page will pop out:

42 Settings - - E% =
IF: 192 .18 . &5 .10 5038
Uzer Name: efonadmin
Pazzword: *S0e SO0
Extenzion: 62473
Start Program when computer starts

Figure 6

IP: The IP address of MyPBX whose operator panel you want to logon. Don't
change the 5038 port please.

User name: the user you've set on “"AMI settings” page.

Password: the password you’ve set on “"AMI settings” page.

Extension: The extension number of the corresponding MyPBX.

After changed these settings, you will logon the eFon Operator Panel.
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2. Distribution of eFon Operator Panel page

Trunk status, history, extension groups, toolbar and status bar can be remove
from or add in the page from ‘View’ menu.

eFon Operator P
File Tools View Help

s 50080680 S
® o o ® ©¢ © ® @ © o o

| »

5503301 5503305 5503302 5503306 5503309 550331 5023060 50230681 5023085 5023062 SLUGEA pebald
Trunk Status i
pstnl3 pstnl4 5503303 5503310 Chianmobil Chianmobil Chianmobil Chianmobil NeoGateTG2MeoGateTG2Manufactur -
Active Call Hiztory
| Line Hame | Call Type | Caller | Callee ‘ Duration | | Line Hame ‘ Caller | Callee
b 4 Internal B243 AR (B043) 00:00:48 ) 5503309 BT (Boz0) a1z
History
Active Call
] I ¢
A1 i
~ ~p ~p -~ -~ ~> ~p ~p
IFER 6202 6203 635 SR 6206 6207 6208
Extension Group Extensions
— — — A - — —~ —
. 4 . 4 . 4 . 4 - 4 . 4 ~ . 4
6209 6210 6211 6212 6213 6214 6215 6216
— — — — —~ —~ — —~
J J J @ F J I J |
6217 6218 6219 6220 6221 6222 6223 6224
~ =5 =5 =5 e 0 -0
| 6225 6227 6241 6242 5243 6244 6245 6246 -
Ready| Tatus bar MNUM

Figure 7
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3.How to make a call from your extension

In all the text we suppose the outbound route of MyPBX which we use is as
follows and the dialed external number is 1820592XXXX.

Edit Qutbound Route - pstnout X

Route Name®¥- pstnout
Dial Pattern®@®- 9.
Striphd: 1 digits from front
Prepend these digits@': before dialing
Password:
T.38 Support®@: No -
Rrmemory Hunt& - Yes -
Member Extensions &
Available Extensions Selected
601(FXS3) - 5002(SIP) -
602(FXS) (=] LR 5003(SIP) (=1
R001(SIP) i 5004{SIF)
5011(SIP) — 5005(SIP)
REEE(SIP) - 5006(SIP)
5556(SIP) 5007(SIP)
REET(SIP) - 5009(SIF)
5558(5IP) 57 6001(SIP) 7
Member Trunks'@
Available Trunks Selected
5503305(FX0) - 5503309(FX0)
A503306(FX0) il BB 5503301(FX0)
E1Trunk1(E1) ! 5503310(FX0)
E1Trunk2(E1) 3 — 5503302(FX0)
Chianmobile180(SIP) —
Chianmobile181(SIP) i
Chianmobile182(SIP) -
Chianmobile183(SIP) 57
o Save | | & Cancel

Figure 8

3.1 How to make an internal call

You can make an internal call in two ways:
1.Fill the extension number you want to dial in the number ling, then click the
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‘call out’ key.

-
42, eFon Operator Panel - 6243 E@g

File Tools View Help

6048 U_|°@&|
® ® ®© & ® o O O o o o o

5503301 5503305 5503302 5503306 5503309 550331 5023060 5023061 5023065 5023062 5023063 pstnl2

pstnl3 pstnld 5503303 5503310 Chianmobil Chianmobil Chianmobil Chianmobil NeoGateTG2MNeoGateTG2Manufactur

»

m

Aotiwve Call | Error i History
| Line Hame | Call Type | Caller | Callee ‘ Duration | | Line Hame ‘ Caller | Callee
o 5503309 13 ZFRERE (B009)
&) 5503301 BT (B0z0) g
() 5503309 BT (50200 ER
“ T 2
A1 i
9 7 g 9 2 4 2 4 7 I
3 RS FHE R Jason Bl wE= 3

g 9 9 9 9 g

6024 PRI Bt SERRE FKIE wEE

9

g 9 9 9 g g 7

iv By Be BY
d

=R BEX 6037 s g =] B
7 7 9 | Q9 9 7
E2=E FEn b= HEE 5] MR HEE -
Ready MNUM
Figure 9

After click the ‘call out’ key, your extension will ring, answer the call, your
extension will call the extension you dial automatically.
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-
43, eFon Operator Panel - 6243 @M

6045 OQoe0oaz8 9
® ® ® ¢ ® ¢ ® O o o o o

5503301 5503305 5503302 5503308 5503309 550331 5023060 5023061 5023085 5023062 5023063 pstnl2

® & ® ® o o o o o o O

] »

m

pstnl3 pstnld 5503302 5503310 Chianmeobil Chianmobil Chianmebil Chianmebil NeoGateTG2MeoGateTG2Manufactur -
Actiwve Call History
Line Name Call Tvpe Caller Calles Iuration Line Name @ Caller Callee
,@Q Internal 5243 ALAEKE (B048) 00:00:15 | 05503309 13 AR (B003)
QY 50330 SHIEHF (80207 91
Q) 50330 SRIBSF (B020) st
| [ | 3
AL Rl =EE FEE HEE Jason Bl BT wHEE -

>y 2 92 9 9 9 2 2

6024 5k il FERRE SRIE wEE BE ERiE

m

7 7 4 2 7 4 4 7

BEEE 5308 6037 SRIE EINE =i =i BS
. . - -3 P . . .
? 2 > ¥ 2 2 2 2

FE=E ZEH AE LaEE wES o s KRR

> 2 2 2 2 2 2 2

Ready MNUM

Figure 10
2. Click the extension which you want to dial twice, then your extension will ring,

answer the call, your extension will call the extension you dial automatically.

3.2 How to make an external call

You can make an external call in two ways too:

1. Fill the number you want to dial in the number line (please follow the dialing
rule of outbound route), then click the ‘call out’ key.
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% eFon Operator Panel - 6243

= [ B [ |

After click the ‘call out’ key, your extension will ring, answer the call,

-
File Teols View Help
[[ovac ] u]glma@ @80
5503301 5503305 5503302 5503306 5503309 550331 5023060 5023081 5023065 5023062 5023063 =
I pstnl2 pstnl3 pstnld 5503303 5503310 Chianmobil Chianmobil Chianmobil Chianmobil NeoGateTG2ZMeoGateTG2 -
I Active Call History
| Line Name | Call Type | Caller | Callee ‘ I | Line Name | Caller | Callee | 1l I
o 5503301 unlmow BzeZ o
(| 0 5503310 Taszon (G013) 95503301 oc 3 I
° 5503303 Tazon (B013) 95503301 oc
) s50a301 5503303 FRB (828 (B0381) oc
I ) 550302 6243 O] — of _| [
4 il | 3 < m | +
e < =4 & & - - = -
= Erviza) HE FEF GERE IREE FE
? 2 2 2 92 2 2 O
IFE% R WE HEE =E=d RETL FHE
v 9 9 9 g9 g 9 !
o) Fh FE= T e e REZ -
Ready NUM
Figure 11

extension will call the number you dial automatically.

your

r _—
42, eFon Operator Panel - 6243 E‘Eu
File Tools View Help
91508 U@@@@ 0 & O
® ® & ® ¢ o o o B
5503301 5503305 | 5503302 5503306 5503309 550331 5023060 5023061 5023065 5023062 5023063 pstnl2
pstnl3 pstnld 5503303 5503310  Chianmobil Chianmeobil Chianmoebil Chianmebil NeoGateTG2MeoGateTG2ZManufactur -
Active Call History
‘ Line Name | Call Type | Caller | Callee ‘ Duration ‘ Line Name | Caller | Callee
I&SSDBBUZ Call Out BZ43 a1a 00:00.25 o 5503309 13 ZFRE B00a)
Q 5503301 HIBNT (B020) 91E
() 5503309 SHIBAF (Boz0) a1z
« m "
A1 o o . - -~ - -~ -~ i
7 7 7 24 24 24 24 24
6217 6213 6219 6220 6221 6222 6223 6224
g 9 9 9 |9 9 9
6225 6227 6241 6242 FRIE] 6244 6245 6246
g 9 9 9 9 9 9 9
6247 6243 6249 6250 6251 6252 6253 6254 i
2 2 2 2 2 2 2 2
6255 6262 Py bl i HERE HEL HE
Ready NUM
= =

Figure 12
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The trunk used here is 5503302, so trunk 5503302’s indicator will turn green
(busy) from blue (idle) in trunk status field. The red indicator here presents

unavailable.

2. Make a call to your contacts.

File->edit contacts, right click the number you want to dial (the number should

follow the dialing rule), click call, then your extension will ring. Answer the call,

then it will call out.

82, Contact

88X

Name Comparny Job Title

Pixar Yeastar

Office Phone Mobile

Figure 13
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4. How to transfer a call

When you are on the phone, you can transfer your call to others on the Panel.
There are two ways to transfer calls.

1. When you are making a call with A. Fill in B’s number in the number line, click
transfer key, B will ring. When B pick up the phone, you can talk to B. Then
you hung up the call. A and B will have conversation. That means you
transfer the call to B.

-
42, eFon Operator Panel - 6243 L

— . L

-
File Tools View Help
604 \ﬂ@@l\ﬁld 289
5503301 5503305 5503302 5503306 5503300 550331 5023060 5023061 5023065 5023062 5023063 pstnl2
pstnl3 pstnld 5503303 5503310  Chianmohil Chianmohbil Chianmobil Chianmobil MeoGateTG2ZNeoGateTG2Manufactur -
Aective Call History
Line Name Call Twvpe Caller Callee Iuration Line Name | Caller Callee [l
|@ Internal 5243 HSEHE (B048) 00:00:22 I ) 5503303 Jazon (5013) 95503301
©) 5503301 5503303 PBL (28 (5038 =
O 5503302 B243 a1e
05503309 137 FBAE (goos)
&) 5503301 SHIT (BO20) 1% i
4 [ | 3
AL i
~ ~ ~ ~ —~ ~ ~ ~
v v v > > 9 9 9
IFiEE fac FHE EE Jason Eragl HIET wE= 3
~ ~ < ~ ~ ~ ~ <
v v v 7 7 v v v
6024 (Etey Eigx R IRIE wEE BE ERk
~ ~ ~a ~a ~> ~ ~> ~a
P 9 P 9 > 9 9 I
RER F&EK 6037 A EVE St iz S
—~ ~> ~> > —~ —~ ~ <
b> > >, b> > b> b5 b>
Is= FEW AE LEEEE WES Hk FiErZ KER -
Ready MNUM

Figure 14
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File Tools View Help

Js041 H0oe02& |0

DT D FRIND P D FIVE NI D AT T AN G NPT ) PR TTTT O
5503301 5503305 5503302 5503306 5503309 550331 5023060 5023061 5023065 5023062 5023063 pstnl2
® ® ® ® ¢ o o o o o O

pstnl3 pstnld 5503303 5503310 Chianmobil Chianmobil Chianmobil Chianmobil NeoGateTG2MNeoGateTG2Manufactur

Active Call Hiztory I
| Line Name | Call Type | Caller | Calles ‘ Duration | | Line Name ‘ Caller | Calles |l
§5503301 Call In PSTHES033. .. BEZZ 00:00:06 ) 5503310 Jazon (B013) 95503301
o 4 Internal HeERAF (B048) FRRESE (041) 00:00:21 ) 5503303 Tason (B013) 95503301 =
D Internal 6243 SEAHHE (50480 00:01:47 ©) 5503301 5503303 BREY (528 (8036
) 5503302 6243 918 4
o 5503309 137 . — FRRE (go09)
4 I 2
M1 ~ — = — ~ e — < -
> v 4 4 7 9 v 4 T
BERs BEE H=e o= 5005 Michael feiii = =
— = P ~ P = — = 4
v 4 4 > 24 9 v 4
Rl oA FHEE HERE Jason B I wE=
~ = P = P ~ — =
9 v v 4 7 > 9 9
6024 (e Bl FEIFRE 3KIE wEE BE =
~a — — — ~~ — —
9 7 9 9 > 9 9 9
FE FEEL 6037 SEHE EE B s B
Ready MNUM I

Figure 15

2. When you are making a call with A, right click the extension B which you want to

transfer your call to and choose ‘Transfer to’. B will ring. When B pick up the phone,

you can talk to B. Then you hung up the call. A and B will have conversation.

That means you transfer the call to B.



"
® Yeastar eFon User Manual

-l

(53 <Fon Operator Pan [ )
File Tools View Help

5013 HO00R0@&[O
S e e B B B N B B B B

5503301 5503305 5503302 5503306 5503309 550331 5023060 5023061 5023065 5023062 5023063 pstnl2

pstnl3 pstnld 5503303 5503310 Chianmobil Chianmobil Chianmobil Chianmobil NeoGateTG2MNeoGateTG2Manufactur

Active Call Hiztory
| Line HName | Call Type | Caller | Callee ‘ Duration | | Line HName ‘ Caller | Callee ot
Fo 4 Internal Bed3 HEEHE (B045) 00:00:08 ) ss03301 urdmow [
o 5503310 Jason (B013) 95503301 3
0 5503303 Jason (B013) 95503301
©) ss0z301 5503303 PR (628 (BO36
o 5503302 B243 a1 H
1] (T 3
m g 9 9 9 9 9 9 9 -
BEZER  EES Bl L= 5005 Michael #hH= e =

2 9 9 9 R : 7
e |
FEHE =HIERE FRE HEE 3¢ i wEE

Pick up
— Hang up I
‘} ‘? ‘? ‘@ Create a Call @
6024 EREe s bl : 2 SRk
Refresh
SO0 1 e A
FE FREX 6037 KEE EMNE i s BE

Ready MNUM

Figure 16
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5.How to create a call

You can create a call between two extensions or create an external call for an
extension on the Panel.

1.Create a call for two extensions

Click ‘create a call’ key in the Toolbar or right click in the extensions field and
choose ‘create a call’.

F ™
2, efon Operator Panel - 6243 . = -l e - “ N E@ﬂ

File Tools View Help

EE NO@& O o@@
® ©® o ® o ® & ® o o E

5503301 5503305 5503302 5503306 5503309 550331 5023060 50230681 5023085 5023062 5023063 pstnl2 ‘ ‘

® ¢ ® © o o & o o o O

I

pstnl3 pstnl4 5503303 5503310 Chianmobil Chianmobil Chianmobil Chianmobil NeoGateTG2MeoGateTG2Manufactur -
Active Call Hiztory
Line Name Call Type | Caller Callee Duration Line Name Caller Callee s
o 5503301 unliow B22Z
B 5503310 Jason (B013) 95503301 3
B 5503303 Jason (B013) 95503301 B
) 5503301 5503303 BEL (828 (8036
0 5503302 B243 X i
4 m | +
M1 —~ —~ PN —~ ~ — —~ . -
J 9 7 v 2 g 9 v T
BEES fFEE s RS 5005 Michael fati iy P2 ‘ =
~a ~ ~ ~ —~ —~ ~a —~ —
9 9 9 >, P > b> 9
Pl RIS FHE EE as| Call i fa
Pick up
? 4 9 9 9 i Hangup 9
6024 B EERs R 4 Create a Cal =R
Refresh !
=R FEEk 6037 SEHE == =L f=iinsad B
Ready NUM
Figure 17

A window pops out, you can either fill in the caller and callee’s extension
numbers or click the number field in this windows then click the extension you
want in the extension field.
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82 Create a Call ﬁ

Caller G013

Callee G023

| 0K | | Cancel

Figure 18

Click ok, the caller’s extension will ring, answer the call, then the caller will call
to the callee automatically.

2. Create an external call for an extension

It is similar as creating calls for extensions. The only difference is that you
should fill in the callee number following the dialing rules of outbound route.

82, Create a Call )]

Caller A013

Callee A18C

0k | | cCaneel

Figure 19
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6.How to pick up a call

When other extension is ringing , you can pickup the call on the panel.

There are two ways to pick up a call:

1. Choose the extension which is ringing in the extensions field, then click the

pickup key in the tool bar, the call will be picked up.
B8 <o Operator Panel [

File Tools View Help

||6041

OQEO028&8(Q

5503301 5503305 5503306 5503309 550331 5023060 5023061 5023065 5023062 5023063 pstnl2 ‘ ‘
pstnl3 pstnl4 5503310 Chianmohbil Chianmobil Chianmebil Chianmobil NeoGateTG2NeoGateTG2ZManufactur -
Active Call History
| Line Name | Call Type | Caller | Callee ‘ Duration | | Line Name ‘ Caller | Callee s
é‘ LEEEHF (B048) FEES G041) 00:00:18 05503301 unlmow B222
0 5503310 Jason (B013) 95503301 3
o 5503303 Jason (BO13) 95503301 B
) 5503301 5503303 FEL (828 (8036
o 5503302 B243 a1 i
4 | i | +
a1 ~ ~3 ~3 —~3 ~3 ~> ~3 — -
7 9 7 9 9 J I 7
6024 FEREE: HiEE ol SEIE wEE FIE ERE i
—~ S~ s~ o~ —~ o~ =3 S~ E
v 4 9 4 9 9 9 v
FE FEK 6037 K= B = =ieh BiE
~ ~3 ~ . ~ ~ ~ ~
v 7 9 9 v 9 v v
EE=L FE A= R AEA s T EEE
~> ~3 -~ -3 -~ ~> ~3 -~
9 v v v v 9 v v
Figte R Bz SRHE HE ES Higst ]
Ready MNUM
Figure 20

2. Right click the ringing extension, choose ‘pick up’, the call will be picked

up.
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File Tools View Help

[eo4r OQRO0R& O
O O T O S T O T T T G

5503301 5503305 5503302 5503306 5503309 550331 5023060 5023061 5023065 5023062 5023062 pstnl2 ‘

® & ® ® o o o o o o O L

pstnl3 pstnld 5503303 5503310 Chianmobil Chianmebil Chianmobil Chianmobil NeoGateTG2ZNeoGateTG2Manufactur -
Aotiwe Call Hiztory
Line Name Call Type Caller Callee Duration Line Name | Caller Callee Jat
‘-j": Internal SEEEEE (B048) HEEEE B041) 00000:12 ©) 5503301 unbmow 5202
0 5503310 Jason (G013 95503301 3
O 5503303 Jason (BO13) 95503301 | &
) ssoas01 5503303 BABL (25 (5035
0 5503302 B243 91 N
e [ — 3
K11 m
- ~ - - ~ S~ == ~
9 9 9 9 ? 9 ;
s 0 FmE  EE ERE E— B
‘ Pick up ‘
> ~z - > —~ o~ - Hang up 3
Q Q od Q’ Q Q ’ Create a Call B
IEE == nE HERE EE HEE i
Transfer 3
> 7 g 9 7 7 Pl Refreh
et FhBEAN #hE SR HIhE IEEfE Hias FReEEE
e — . = . i — .
bo > 2 9 9 > > I
=) IEE W= "E BEE e HE EE -
Ready NUM

Figure 21

7.How to set Auto Pickup

You can set auto pickup in the panel, so that you can auto pickup the calls when
the extensions selected haven’t pick up the call for a given time.

You can set auto pickup in this way: Tools -> Options -> Auto Pickup.

Click ‘Auto Pickup’ to enable this function.

Time: Auto Pickup the call after the extensions ring how many seconds.

All Extensions: Auto pickup all extensions.

Selected Extensions: Auto pickup the selected extensions.
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MyPEX Operator Panel - Optione. TR THENEE TR TR W (A

system AtoPickp
=== Ao Pokap

Time: 15 5

7 Al Edensions

(@ Selected Extensions

BExtensions: Selected:
 Boz4 3 1y 6028 BRI
1 BO2T (L) ) 6028 GERNERE)
|
1y 6023 GKIE) 2 B30 SR ,

@ o= %D

2 6038 G0

@ BOST
7 6038 GRFNE)

7 8033 () - |
4 I 3 L L 3

Figure 22
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8.How to change logon information

If you have to change the logon information, such as logon another extension or
another server, you can do it like this:

Tools -> Options -> System, then you can change the information and click ok
to logon the new one.

MyPBX Cperator Panel - Options - — — ' ]
System System
Auto Pickup

IP: 192 168 . 5 . 1N 5038

User Mame: | efonadmin|

Password: eessssss

Extension: 6243

[7] Start Program when computer starts

ok (s ] [

Figure 23

<Finish>



